Introduction to Modern Scholarly Communications

Amanda Page & Anne Rauh
September 29, 2017
Agenda

» Introduction

» Scholarly Communications

» Open Access

» Scholarly Impact
Eureka!
SURFACE Repository Map, 2017
» Traditional or Conventional Publishing
» Open Access
» Multi-Media and Interdisciplinary
Scholarly Communications Lifecycle; ACRL Scholarly Communications Toolkit.
Scholarly Communications Lifecycle; ACRL Scholarly Communications Toolkit.
Research & Data

» Eureka! Idea!

» Define Audience, Goals, Purpose

» Run Experiments

» Create!

» Apply for Federal Grants or Funding

» Consider Next Steps:
  ▪ Budgets
  ▪ Federal Mandates for US Grants
  ▪ Life of Experiments
Considerations

» Literature or Systematic Reviews
  ▪ All of Library

» What grants to apply to, and how?

» Need for public access to research?

» Need for data management planning?

» Assistance with research?
  ▪ Systems- Citations Management- Finding Information-
  ▪ Licenses- Subscriptions and conduit to Open Source systems and Open Access Research
Considerations

» Format of works created from research?
» Where to submit after research phase?
» Rights and Re-use?
» Quality Assessment of publications
» Author Rights and Copyright
Authoring Phase Considerations

» Format of works created from research?
» Audience?
» Open Access or Traditional?
» Where to submit after research phase?
» Rights and Re-use?
» Quality Assessment of publications
» Author Rights and Copyright
Scholarly Communications Lifecycle; ACRL Scholarly Communications Toolkit.
Peer Review

“designed to assess the validity, quality and often the originality of articles for publication.”

https://authorservices.wiley.com/Reviewers/journal-reviewers/what-is-peer-review/index.html
Peer Review Considerations

» Blind Peer Review
» Medical Peer Review
» Conference Proceedings and Grants
» Books and Articles
» Not for pay
Peer Review Considerations

» Where do I want to submit my publication to?
» Is Peer Review Important?
» What Impact do I want to make?
» How quickly do I want my work published?
» Is blind or double-blind peer review important?
» Quality important in all types of publishing
Peer Review Considerations

- Citation Management
- Literature and Systematic Reviews
- Similar Works
- Quality Assurance
- Ethical Standards
- Definitions of PR and why important
Scholarly Communications Lifecycle; ACRL Scholarly Communications Toolkit.
Publication

» Library as Conduit
» Library as Publisher
Scholarly Communications Lifecycle;
ACRL Scholarly Communications Toolkit.
Discovery & Dissemination

» Metadata
» Cataloging
» Research Identifiers
» Institutional Repositories
» Library Catalogs
» Preservation, Safeguarding
Open Access
“Open Access (OA) literature that is online, digital free of charge and free of most licensing restrictions.”

Peter Suber, 2014
Open Access

» Works alongside Copyright

» Broader re-use rights

» Broader rights for authors
Types of Open Access

» Gold Open Access (Journals)

» Green Open Access (Repositories)
OA Journals

» Perform peer-review, then make content freely available

» Fully OA journals (all OA)

» Hybrid journals

» Expenses vary - Costs paid through various economic models

» Author Rights
OA Repositories

» Make content available for free

» Institutional, Disciplinary
  ▪ (also called subject)

» Preservation

» Self archiving

» Author Rights
OA Repositories

Open Access Repositories

» Inclusive of various format types:
  ▪ Preprints
  ▪ Post prints
  ▪ Conference proceedings, posters
  ▪ Grey literature
  ▪ And more!
  ▪ Copyright

Format types unique to each repository
SURFACE: surface.syr.edu

» Inclusive of various format types
» Inclusive of many subject matters
» All authors affiliated with SU
» Copyright Curation
» Works with publisher policies, author rights, and copyright.
» Scholarly & Citation Impact
Scholarly Impact

“quantitative data on the impact of scientific and scholarly research”

http://www.arl.org/focus-areas/scholarly-communication/scholarly-impact
Traditional Metrics

» Impact Factor
» Citation counts
» H-index

Scopus®
WEB OF SCIENCE™
Google Scholar

JOURNAL CITATION REPORTS
“the volume and nature of attention that research receives online”

http://www.whatareatmetrics.com/what/
Almetrics

» Viewed
» Discussed
» Shared
» Saved
Altmetrics

Triple triumph: Three women in medicine

Editor(s)
Samuel Gorowitz, Syracuse University
Cathryn R. Newton, Syracuse University

Download Full Text (12.1 MB)
PDF formatted for accessibility (12.1 MB)

Description
Triple triumph: Three women in medicine is the story of three physicians.

Three physicians, all women, each perceived serious unmet needs in their fields, and envisioned imaginative approaches to meeting those needs. Each encountered resistance, discouragement, and obstruction from the traditional, male-dominated departments in which they worked. These powerful pioneers, undeterred, created programs that earned the highest levels of national distinction and acclaim. Their work and their names are now legendary—in geriatric medicine, in the treatment of breast cancer, and in diabetes research and treatment. Their stories differ, but the commonalities help us understand why constructive change is often so hard-won, and what it takes in commitment, courage, and tenacity to triumph in the end. Sharon Brangman, Patricia Numann, and Ruth Weinstock are inspiring heroes, from whom we can all learn essential lessons.
### Observation of Gravitational Waves from a Binary Black Hole Merger

Overview of attention for article published in Physical Review Letters, February 2016

<table>
<thead>
<tr>
<th>SUMMARY</th>
<th>News</th>
<th>Blogs</th>
<th>Twitter</th>
<th>Facebook</th>
<th>Wikipedia</th>
<th>Google+</th>
<th>Reddit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Observation of Gravitational Waves from a Binary Black Hole Merger</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Published in</td>
<td>Physical Review Letters, February 2016</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOI</td>
<td>10.1103/physrevlett.116.061102 (🔗)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pubmed ID</td>
<td>26918975 (🔗)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Authors</td>
<td>B. P. Abbott, R. Abbott, T. D. Abbott, M. R. Abernathy, F. Acernese, K. Ackley, C. Adams, T. Adams... (show)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abstract</td>
<td>On September 14, 2015 at 09:50:45 UTC the two detectors of the Laser Interferometer Gravitational-Wave... (show)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### About this Attention Score

In the top 9% of all research outputs scored by Altmetric

#### Mentioned by

- **120** news outlets
- **52** blogs
- **4164** tweeters
- **114** Facebook pages
- **40** Wikipedia pages
- **216** Google+ users
- **2** Redditors
- **8** Q&A threads
- **1** video uploader

#### Twitter Demographics

The data shown below were collected from the profiles of 4,164 tweeters who shared this research output. [Click here to fin]
Anne Rauh
Syracuse University Libraries Collection Development and Analysis Librarian

**Open Hero**
Top 10%

Every single one of your papers is free to read online. Wow! That's a level of access only 2% of other researchers achieve. Open access helps real people, and that's pretty heroic.

**Greatest Hit**
Top 50%

Your top publication has been saved and shared 19 times. Only 32% of researchers get this much attention on a publication.

**Global Reach**

Your research has been saved and shared in 8 countries.

**Timeline**

19 Online mentions over 6 years

**Publications**

- Introduction to altmetrics for science, technology, engineering, and mathematics (STEM) librarians
  2013 Science and Technology Libraries
  19

- Telling Our Story: A Case Study of a Collaborative Departmental Blog at Syracuse University Libraries
  2016 New Review of Academic Librarianship

- There's an app for that: Using google scholar citations to profile scholars' work
  2014 Issues in Science and Technology Librarianship
Scholarly Profiles

» Google Scholar
» Selected Works
» Experts@Syracuse
» Mendeley
» Research Gate
» Academia.edu
## Patrick Williams

**Syracuse University**
Verified email at syr.edu

### Paper List

<table>
<thead>
<tr>
<th>Title</th>
<th>Cited by</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection understanding [visualization tools in information retrieval]</td>
<td>55</td>
<td>2004</td>
</tr>
<tr>
<td>M. Chang, J. Lyngell, R. Furuta, A. Kerr, J.P. Williams, S.A. Burns, R.G. Bias</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use of multi-modal media and tools in an online information literacy course: College students' attitudes and perceptions</td>
<td>12</td>
<td>2009</td>
</tr>
<tr>
<td>H.L. Chen, J.P. Williams</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Journal of Academic Librarianship 36 (1), 14-24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedagogical design for an online information literacy course: College students' learning experience with multi-modal objects</td>
<td>12</td>
<td>2009</td>
</tr>
<tr>
<td>H.L. Chen, J.P. Williams</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Canadian Journal of Information and Library Science, 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost justification</td>
<td>2</td>
<td>2008</td>
</tr>
<tr>
<td>J. Williams, R. Bias, D. Mayhew</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Human Computer Interaction Handbook, 1267-1278</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Doing It Yourself: Special Collections as a Springboard for Personal, Critical Approaches to Information</td>
<td>1</td>
<td>2015</td>
</tr>
<tr>
<td>P. Williams, L. Mutnoney</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Just Where to Click: Teaching Students How to Think About Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impact of media and interaction variety on student attitudes in a web-based undergraduate course</td>
<td>1</td>
<td>2005</td>
</tr>
<tr>
<td>H.L. Chen, J.P. Williams</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proceedings of the Association for Information Science and Technology 43 (1 ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>What Is Possible: Setting the Stage for Co-Exploration in Archives and Special Collections</td>
<td>2016</td>
<td></td>
</tr>
<tr>
<td>P. Williams</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Critical Library Pedagogy Handbook, Volume 1: Essays and Workbook Activities...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Selected Works

Selected Works of Peter D Verheyen

Librarian | Research and Emerging Issues Analyst, Syracuse University Libraries

For a complete record of his professional activities please view his Curriculum Vitae online. ORCID | VIAF

Peter D. Verheyen is Research and Emerging Issues Analyst in the Program Management Center, Syracuse University Libraries. This position assists the Library in identifying, processing, analyzing, interpreting and maintaining the information in

Search works of Peter D Verheyen

Bookbinding and the Book Arts (17)

Die Collins: W. Collin, Hofbuchbinder & Ernst Collin, der Autor ...
(2016)

Peter D Verheyen

The Berliner Buchbinderel W. Collin mit ihren Leitfiguren Wilhelm und Georg Collin, die letzten Hofbuchbinder zu den preußischen Königen

The Collins: W. Collin, Court Bookbinders & Ernst Collin, the ...
(2016)

Peter D Verheyen

The Berlin-based firm of W. Collin led by Wilhelm and Georg Collin and the antiquarian, author, and editor Ernst Collin ...
Research Identifiers

» VIAF - Virtual International Authority File
» ISNI - International Standard Name Identifier
» ORCID - Open Researcher and Contributor ID
Research Information Management

- Instructional history
- Researchers, affiliations, collaborators
- Activities, service, awards
- Media reports
- Research outputs (Patents)
- Grants & projects
- Statements of impact
- Equipment
Fingerprint

Fingerprint is based on mining the text of the person's scientific documents to create an index of weighted terms, which defines the key subjects of each individual researcher.

- Library
  - Social Sciences
- Humanities
  - Social Sciences
- Data
  - Social Sciences
- Function
  - Social Sciences
- Project
  - Social Sciences
- Resources
  - Social Sciences
- User
  - Social Sciences
- Need
  - Social Sciences
Future Presentations

» Friday, October 27th, 2:00 pm, Authors’ Rights

» Friday, December 1st, 11:00 am, Copyright and Fair Use

» Friday, February 2nd, 2:00 pm, Digital Humanities

» Friday, March 2nd, 11:00 am, Research Data

» Friday, April 6th, 2:00 pm, Scholarly Impact
Open Access Week

Look for more events the week of October 23rd to 29th
Questions?